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Housekeeping Tips

i ™ 8

Today’s Webinar is scheduled for 1 hour

The session will include a webcast and then your questions will be answered live at the end of the presentation

All dial-in participants will be muted to enable the speakers to present without interruption

Questions can be submitted to “All Panelists" via the Q&A option and we will respond at the end of the presentation

The webinar is being recorded and will be available on our INFASupport YouTube channel and Success Portal - where
you can download the slide deck for the presentation. The link to the recording will be emailed as well.

Please take time to complete the post-webinar survey and provide your feedback and suggestions for upcoming topics.
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https://success.informatica.com/explore/tt-webinars.html

Feature Rich Success Portal

do o )

Bootstrap trial and Enriched Customer
POC Customers Onboarding
experience
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e

Product Learning Informatica
Paths and Weekly Concierge
Expert Sessions

@

N

Tailored training and
content
recommendations




More Information

.u@

Success Portal Communities & Support Documentation University

https://success.informatica.com https://network.informatica.com https://docs.informatica.com https://www.informatica.com/in/ser
vices-and-training/informatica-
university.html
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Safe Harbor

The information being provided today is for informational

purposes only. The development, release, and timing of any
Informatica product or functionality described today remain
at the sole discretion of Informatica and should not be relied

upon in making a purchasing decision.

Statements made today are based on currently available
information, which is subject to change. Such statements
should not be relied upon as a representation, warranty

or commitment to deliver specific products or functionality

in the future.
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Safe Harbor

The information being provided herein is for informational purposes only. The
development, release and timing of any Informatica product or functionality
described herein remain at the sole discretion of Informatica and should not be
relied upon in making a purchasing decision.

Statements made herein are based on information currently available, which is
subject to change. Such statements should not be relied upon as a representation,
warranty or commitment to deliver specific products or functionality in the future.
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Axon Data Governance Release Timeline

April June

2021 JU'>2\021 OCt/zim Jan/2\022 20/2\2 Dec 2022
O—® @& @& —@ P —
Axon 7.2 Axon 7.2.1 Axon7.2.2  Axon7.2.3 Axon 7.3 Axon 7.3.1
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Axon Governance Themes / Priority Areas

Customer Imperatives

Focus on critical customer features for continued
governance success and expansion

Core and Extended Features

Extend and complete existing Axon features including
segmentation, workflows
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Product Usability

Continue to enhance capability with usability as the
focus

Cross Product Integrations

Ensure smooth, end-to-end cross product
experiences with EDC, DPM and DQ

( Informatica



Axon Data Governance Release highlights

@ Engaging

Integrated

Outcomes

Axon .
7.2.1

(Jul 2021)
[ )

Unison usability
Improvements
Edit widgets in Dashboard

Axon EDC Onboarding
enhancements
Custom Fields for DQ Facet

Delete default dropdown
values

Content migration
Notifications management

Axon .
7.2.2 .

(Oct 2021)

Added Map Legend
Dynamic Date filter
QuickLook update to show
addl Details

Duplicate Table Handling
during On-boarding
Notification for Tagged user
DQ Failure email notification

API support for Change Req
SSO support for QuickLook
Multi Select custom field
Improved Bulk Delete

Axon .
7.2.3

(Jan 2022)

Dataset to Data Collection
Relationship

QuickLook Chrome plugin
Hierarchy sorting

Additional EDC resources
DQ Automation extension

Accessibility updates
Audit improvements
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* Additional EDC Resources and DQ Automation Source
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Axon Data Governance /.2.1 — Highlights at a glance

Engaging

* Unison improvements
« Search Preferences persistence
» Filtering based on DQ Status
» Hierarchy path in Union grid
» Access control on non-public
assets in Unison
« Ability to edit Dashboard widget

© Informatica. Proprietary and Confidential.

Integrated

* Axon - EDC Integration
» Additional resources - Power B
& AWS Glue
« Onboarding for duplicate
System scenarios
« AXON-DQ Integration
» Custom Field support for DQ

Qutcomes

Delete Default Values for Dropdown
Content Migration across
Environments
Notifications management
Object pages enhancements
» Hiding standard fields in Object
pages
» Hierarchy page for System
facet

(‘ Informatica



Unison Enhancements
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Glossary hierarchy in
Unison

» Earlier, when the user was looking at the @ e B o =
Glossary within Unison, there was no e
information that showed the domain (top
level Glossary) this object belongs to B ravon

> Name < Type Definition ] Parent Name

v M Pany Classifications Party Classifications of all sorts. Good classifications are exhaustive sets of... [Show B Fart
-"‘“ ¢ M Pa
PartyData > Party Classifications More]

« Now, additional information about the top-
level glossary and the hierarchy helps user V
quickly understand the right glossary when P o
there could be multiple with similar names - @ s

Party Data > Party Classifications > Party Type > Status of party as per KYC/KYB regulation. Party Type

v W Pany Type i -
- EEEEE Classification of the type of party. g Party Classifications
Party Data > Party Classifications > Party -

v M Bankof England Institution Codes

Bank of England classification of financial institutions.(saving lay-out when c... [Show
PartyData > Party Classifications > PartyType > | ENTITY o W Party Type
Bank of England Institution Codes
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Glossary Hierarchy in Unison

* Expand per row as per the need

<> DATASETS ATTRIBUTES & SYSTEM El GLOSSARY
== 1mof1n 588 of 588 = 12601126 =l 598 of 598
B List /% Dashboard
<> DATASETS @ ATTRIBUTES o SYSTEM E' GLOSSARY
- = 1mof1m 588 of 588 = 1260f1 —
oM 2 Type Definition 111 of 111 588 of 58 = 126 0f 126 598 of 598
Parties are entities th:

| Party Data ENTITY <

L Y More] Bl List /A, Dashboard

R S Party Classifications ¢ > A L
> | Party Classifications ENTITY Name v Type Definition

B Pary el

Parties are entities that have a economic relationship of some sort with the co.. [ Show
> M| Party Type Classification of the ty M| Party Data il P [
ore
> M| MIFID Classification Classification of party g __
El Party Classifications Party Classifications of all sorts. Good classifications are exhaustive sets of.. [ Show
ENTITY
> M| KyC/KYB Status Status of party as per PartyData > Party Classifications More]
> M| Party Type Classification of the type of party.
B M| MIFID Classification
Party Data > Party Classifications > Party Type > Classification of party as per MIFID regulations.
MIFID Classification
> M| KYC/KYB Status Status of party as per KYC/KYB regulation.
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Glossary Hierarchy in Unison

- Expand all at once and include it in the export as well

Party Classifications of all ¢ Expand to view hierarchy for all Glossary objects and to view the Hierarchy column in the exported file. |

<> DATASETS ATTRIBUTES & SYSTEM
== o 588 of 588 = 12601126
B List /% Dashboard
> Name < Type Definition
Parties are entities that hav
| Party Data ENTITY
B Pany el
> M| Party Classifications ENTITY
B Pary el
> M Party Type Classification of the type of
> M| MIFID Classification Classification of party as p¢
> M| KyC/KYB Status Status of party as per KYC/

© Informatica. Proprietary and Confidential.

El GLOSSARY
—=] 598 of 598

<> DATASETS
== o

Bl List

l : iName

/A, Dashboard

@ ATTRIBUTES

< Type

. SYSTEM El GLOSSARY
—_ 598 of 598

26 of 126

Definition

M| Party Data

v M| Party Classifications

Party Data > Party Classifications

v M| Party Type

Party Data > Party Classifications

v M| MIFID Classification

Party Data > Party Classifications
MIFID Classification

v M| KYC/KYB Status

Party Data > Party Classifications
KYC/KYB Status

> Party Type

> Party Type 2

> Party Type >

ENTITY

Parties are entities that have a economic relationship of some sort with the co.. [ Show
More]

Party Classifications of all sorts. Good classifications are exhaustive sets of.. [ Show
More |

Classification of the type of party.

Classification of party as per MIFID regulations.

Status of party as per KYC/KYB regulation.

‘ Informatica



Glossary Hierarchy in Unison

* Long hierarchies truncated by default and can be expanded

v M| The actual exclusive Object that we are
looking for which is minisculed for no reason as it
was termed insignificant

A capaciously long Grand Parent Name that could actual Object
ey have been much shorter and less gigantic 2
& grandiose way to depict the Child Name that v M| The actual exclusive Object that we are

is enormous beyond proportions for no stupendous
reason whatsoever

was termed insignificant
m A capaciously long Grand Parent Name that could

actually have been much shorter and less gigantic >
A similar colossal Parent Name which need not be
this extravagantly massive to convey excessiveness g
> A voluminous Name that should be shortened in actual Object
reality to convey the intent if substantial thought had
been putin > A grandiose way to depict the Child
Name that is enormous beyond proportions for no
stupendous reason whatsoever > The actual
exclusive Object that we are looking for which is

looking for which is minisculed for no reason as it

minisculed for no reason as it was termed
insignificant

© Informatica. Proprietary and Confidential. ‘ |nf0rmatlca



Unison search results behavior (till 7.2)

- Axon objects can be one of two types, I
based on the Axon Viewing option Axon Viewing

— Public Public o

e

* In Unison Search Results

Non-Public
— Guest Users can only view Public objects.

— Logged-in Users can view both Public and Non-
Public objects

© Informatica. Proprietary and Confidential. Q |nf0rmatlca



Hide Non-Public assets in
Unison results

* New option to hide Non-Public objects romat - o omes

Search Settings
Axon Management

* Non-public objects do not appear in Unison
search results for a WebUser that has no O AdninDastooar T
stakeholder role on any object of the facet Fcuaa s S

D Enable fuzzy search

E >
B Meta-Model Administration Finds matching objects even if you misspell, interchange, or miss one of the keywords

type

 Implemented for both Ul Search, as well as
Query API search result

Hide non-public objects
é Operationa | Management > D 4 ) ) N L
Hide objects with the Axon Viewing field set to "Non-Public” for users that are not object stakeholders

18 © Informatica. Proprietary and Confidential.




Save default fields for
Unison search

 Users now have the provision to select the
default fields for each facet S

EI GLOSSARY Name, Alias Names v B -
——=] 598 0f 598

Super Admins have the provision to set the
default for each facet for all users

Add new filter Save Text Search Filters

Reset Text Search Filters Blete \ Bulk Update

Users can override default if they choose. — ey

ic relationship of some sort with the co.. [ Show PR LR SR

Top Level

All

« When the user selects one or set of options Qa 8 A& wesmes
at search and moves across facets, the
prior selections remain as-is

M| Glossary v A Y Q Search My sed

Name, AliasNames v [ ~ X ROLE

\!J 114901 1149

Add new filter Save Text Search Filters @

Reset Text Search Filters @ % Bulk Update

Do not include Children

19 © Informatica. Proprietary and Confidential.




Data Migration
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Data Migration

» Till 7.2, users have the following options to migrate data across environments

— DB backup and restore

— Export and import objects per facet, then manually add relationships/roles

- Starting 7.2.1, Users would now be able to migrate a part of their data to another
environment

— Available for Admin and Super Admin

— Ability to export objects along with roles and relationships and import it in one go in target
environment.

— Facets not in scope: People, Change Request, Active Tasks, Roles*, Physical Fields

* Roles can be migrated for all facets, but we cannot migrate other facet’s data based on roles

© Informatica. Proprietary and Confidential. Q |nf0rmatlca



What gets exported?

 For Active Facet object, the following details will get exported
— Fields (Default + Custom): whatever field is available in bulk upload mapping
— Dependencies(Enforced relationships + Parents)
— Inclusions: Relationships included by user(related object details + relationship templates )

— Roles(if included by user)

 For Dependencies following will get exported:
— Fields (Default + Custom): whatever field is available in bulk upload mapping
— Dependencies(Enforced relationships + Parents)
— Roles(if included by user)

- For related facet object(inclusions) following details will get exported:
— Fields(Default + custom): whatever field is available in bulk upload mapping
— Dependencies(Enforced relationships + Parents)
— Roles(if included by user)

© Informatica. Proprietary and Confidential.




What gets exported?

Active Facet

v

! Objects \\ Roles !
J Calculate
Dependency
Related /
! Objects Exported
Data

’ Bucket
Until we get all

dependent objects

Dependent Objects
(Enforced Relationships and -
Parents)
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nable Data Migration

John Admin System Settings

Super Admin Axon Management

Admin Dashboard
After you make changes to this page, contact the Linux administrator to update the server with the changes. Click here to view the list of administrator tasks.

DG Operating Model

Meta-Model Administration
Group Environment v Cancel

Operational Management

Customize & Configure

Restriction Object @ Access Control List Configuration @ {"method™"allObjectXIP"enforceRoleAcceptance™false} ,
Change Logo
Customize Styles Environment @ Theme @ default
System Settings
Map System Threshold @ 300 Map Dataset Threshold @ 1000
Application Settings
Map Attribute Threshold @ 5000 Default History Duration @ 6
Logs
X Data Migration < S
Admin Activity Logs 9 ° u Clear Notifications @ 0

Enable data migration from Unison search. I

Hide Fields @ O

© Informatica. Proprietary and Confidential. ‘ |nf0rmatlca



Steps to carry out Data Migration

D} Bulk Migrate

Data Migration

Q 2 N [>)

SUMMARY

£ DataSets v Y Filter v Q search My searches v
MIGRATE SELECTED OBJECTS -
OPLE \,} ROLE @ PROCESS + Name
£ Legal Entity Record
@ Bulk Delete * Bulk Update £ BulkMigrate~ ¥+ < 150 Country List
Migrats lects
Lifecycle igrate Selected Objects @ Py ——
Migrate All Objects 0 ——=
Confirmed - Ui $ FXTrade
Confirmed £ M $ Trading Counterparty

INCLUDE RELATED OBJECTS SELECTALL (J
System Glossary
Roles o Client (m]
Legal Entity (m] Product m)

Process O

Policy

. Attribute m)
e Ak Import Migrated Data
Super Admin Import migrated data to populate objects in Axon
Admin Dashboard IMEOREDATA
DG Operating Model
e UPLOAD FILE
Meta-Model Administration SR - g guieds
: i » Axon_datamigration v 0 ) Search Axon_datamigration
Upload a file to import data Axon_datamigration.zip
Operational Management ~
O Name Type
Glossary Rules Engine =
B: Data_Set826628 Microsoft Excel Worksheet
Data Onboarding Rules . :
Glossary586649 Microsoft Excel Worksheet
Administrator's Panel 2 Manifest JSON File
Manage Locks System546356 Microsoft Excel Worksheet

Locked Users
Download Logs

Import Migrated Data
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Pre-requisites

- While migrating roles, users need to make sure

— Corresponding stakeholders are present in target instance

— Role with that name exists

» Since import is going to use bulk upload functionality following need to match in
source and target instance to avoid BU validation errors

— Mandatory Custom Fields at target end need to be present as in source as well
— Dropdown values

— Segments and their privileges incase Admin user is performing

© Informatica. Proprietary and Confidential. Q |nf0rmatlca



custom Flelds
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ustom Fields available for Data Quality facet

Configure Custom Fields

Axon Management

Facets Data Quality X v

Display Name Technical Name Type Default Value Mandatory Last Updated Time Updated By
CF_DataQualityText CF_DataQualityText Text Default text Yes 12-Jul-2021 12:42:56 John Admin
CD_DataQualityDropDown CD_DataQualityDropDown Dropdown Important No 12-Jul-2021 12:43:50 John Admin

DQ-1: All active Legal Entities should have a CMD ID
Local Data Quality Rule

STRAT-2: STRAT-2
Standard Data Quality Rule | Associated Gloss:

SUMMARY STAKEHOLDERS REPORT RELATIONSHIPS IMPACT HISTORY

SUMMARY STAKEHOLDERS REPORT RELATIONSHIPS IMPACT HISTORY

DEFINITION
DEFINITION

All active Legal Entities should have a CMD ID

CMD-ID's are numeric and of length 8 without any leading zeroes.
Reference Number: DQ1

Type: Completeness
Reference Number:

System Measured In: CMD

Type
Measuring Method
echnicel Description. Isnumeric(); h Measuring Method Description DQ Measurement is support by the application
Technical Rule Reference : f Population All Legal Er
S Technical
Create Local Rules Automatically: No iechnicalDescription:
Technical Rule:
~— CF_DataQualityText This is custom text field for DQ Rule
~ CF_DataQualityText Custom Text fiel
~ CD_DataQualityDropDown: Important

——CD_DataQualityDropDown: Not Important

© Informatica. Proprietary and Confidential. ‘ |nf0rmatlca




Custom fields also appear in Unison DQ Filters

DataQuality v 'Y Filter v

DATA QUALI
18 of 281

Add new filter

Q

tribute Name Automation Type Criticality
Frequency

j cMDID Validity High
Measuring Method

3 Legal Name T Completeness Medium
Criticality

3 Legal Name Result Validity High
CD_DataQualityDropDown

3 SIC Code Accuracy Medium
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Edit widgets in Dashboard

« We now can edit a widget after it's created

No need to delete it and re-create it now

One can change the visualization style, title,
description, etc

30 © Informatica. Proprietary and Confidential.

A Home BH My Dashboard x

ProcessincludeChildren

8 Process

BQ Trial Dashboard fo.. x

Grouped by: Lifecycle




Hide Standard fields
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Hide Standard Fields

« Axon provides several fields OOTB but not all fields might be getting used

* Hiding fields of no interest to the users will be helpful
— User will be able to hide certain non-mandatory fields with no values to them

— For 7.2.1, the following facets will be impacted

* Process

» Policy

« Data Set

* Glossary

e System
— Only View -> Summary tab of the above-mentioned facets will have the impact
— Export, Bulk Upload, Unison and Map Overlay Columns will have no impact

© Informatica. Proprietary and Confidential. Q |nf0rmatlca



Hide Fields option in System Settings

John Admin System Settings
Super Admin Axon Management

Admin Dashboard

After you make changes to this page, contact the Linux administrator to update the server with the changes. Click here to view the list of administrator task:

DG Operating Model

Meta-Model Administration

Group Environment
Segments
Custom Fields

Restriction Object @ Access Control List (
Dropdown Configurations
Static Page Editor Environment @ Theme @
Operational Management

Map System Threshold @ 300 Map Dataset Thresh:
Customize & Configure

Map Attribute Threshold @ 5000 Default History Durat
Logs

Data Migration @

Clear Notifications @

Admin Activity Logs

Hide Fields @ O %

Hides the fields that have empty values. If enabled, the fields are hidden in the view mode of Policy, Process, Glossary, Data Set, and System objects.
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Delete OOTB drop down option




Recap — 7.1 Deletion of Drop-Down Options

« With AXON 7.1, deletion of custom drop-down options from Admin Panel -> Meta-
Model Administrations -> Dropdown Configurations is possible

* A custom drop-down option if not in use can be deleted and will not be listed anymore
anywhere throughout AXON including BU templates

A custom drop-down option if in use can also be deleted with a warning validation
message

* Not all options under a drop-down can be deleted. At least one option should be
present within a drop-down

© Informatica. Proprietary and Confidential. Q |nf0rmatlca



Deletion of OOTB/Default Drop-Down options

- Default drop-down options are now allowed/enabled for deletion.

- Default drop-down option deletion follows the same path of validation as custom
drop-down option deletion.

- If the option is in use, then to delete such option

— remove its uses across AXON and proceed with deletion or

— a validation message is thrown asking the confirmation and then deletion occurs

- Some Default drop-down options are prohibited from deletion because of their nature
of impact as well as dependency across AXON.
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Restricted drop downs and their options

« Axon Status : Active and Deleted as they have special significance
- System Type : All options as they drive the system lineage Maps icons

* Process Type : All options as they drive the Process Maps

- Data Set Lifecycle : Draft as onboarded Dataset objects have Draft as default lifecycle

« Access Control Type : All options as they are being used across facets for Axon
Viewing

- Attribute Sourcing Type : All options as they drive the Lineage Recommendations
from Asset On boarder

* Regulation Status : Active and Delete

» Regulatory Theme Status : All options
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Clearing Notifications
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Manual

Catalog ° Roles @ Workflow o Bulk Upload o

- Manually clearing the notifications of each
Sections for user System to Resource Links Removed

08-Jul-2021 01:00:01

Links from System to resources were removed.

— Catalog and Workflow sections will have “Clear
All" button

Clear All

- ROIeS Section Wi” have Catalog o Roles e Workflow o Bulk Upload o

Process Owner

e "Accept and Clear AII" button by USing WhiCh User | Process: EU Gaming Pl Data Retention Process
can accept roles & clear all the notifications

Project Manager
Catalog o Roles @ Workflow o Bulk Upload o Project: Project Nigel

« ‘All Roles’ button by using which this user can go —— < [ Process Owne
to check all the Roles that are assigned to him bt

Uploading of 69 items completed successfully - o
ocess ner

. . Org. Unit : Upload New ltems Process: Is the Pll corporate or customer related?
— Bulk Upload section will have
Uploading of 17 items completed successfully

e 'C I ea r AI I, b Utto n People : Update Existing Items

12-Nov-2018 04:54:33

° 'AI I J O b SJ b utto n Uploading of 3 items completed successfully

Process Owner
Process: ACCOUNT_ENTRY

Process Owner
All Roles Accept and Clear All

Glossary : Upload New Items
12-Nov-2018 04:44:13

Uploading of 8 items completed successfully

All Jobs Clear All
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Automatic / Periodic

- Admin configures the frequency (in no of days) to clear the notifications.

- Every night Catalog, Workflow and BulkUpload notifications that are older than the
Notification frequency set by Admin User are cleared

— Roles Notifications cannot be cleared via this

© Informatica. Proprietary and Confidential. Q |nf0rmatlca



Filter DQ Rules based on result




Filter DQ Rules based on
status of result

« Each Rule has a Target and a Threshold
value against which the scores are
measured

 Scores are categorized as Red, Amber and
Green

 Data Quality Scores based on the latest
report

>= Target . Green
>= Threshold : Amber
< Threshold : Red

 Adding a filter to choose Data Quality Rules
with result in Red/Green/Amber state

© Informatica. Proprietary and Confidential.

CLASSIFICATIONS

BASIC CLASSIFICATIONS
Axon Status:
Lifecycle:

Axon Viewing:

Criticality:

OTHER INFORMATION
Created:

Last Updated By:
Last Updated:

Automation:

® Active
Public

Low

28-May-2021
John Admin

28-May-2021

Frequency:

Run Rule and Retrieve Data:

Daily, at 17:00 hrs

ON

(‘ Informatica



New filter for the Result column in DQ facet for Unison

69
Informatica Search Maps My Items v Create v J John Admin v (2]

FIND v Q Enter the search text Data Quality v Y Filter v Q Search My searches v

<> DATASETS @ ATTRIBUTES — SYSTEM E] GLOSSARY ROLE +
== 0 588 of 5 — o of 131 | o of 598 54 0f 1
11 588 of 588 —RE 3 8 540f 1154
Result Select options
FH List A, Dashboard * BulkUpdate  &¥v
Add new filter
~
Ref. < Name S Description < Attribute Name
CMD-ID's are numeric and of length 8 without any leadin
STRAT2 STRAT2 g yachd
zeroes.
All active Legal Entities should have a 5 55
DQ-1 All active Legal Entities should have a CMD ID ompleteness
CMDID
: s CMD IDs should be of length 8 and leading zeroes are not G a
DQ-2 Primary Customer ID validity g 9 B cMpID Validity High
accepted.
DQC-1 Core Identifier exists All active Legal Entities should have a CMD ID £ cmp Completeness High
DQRULE-3 DQRULE-3 CMD IDs should be of length 8 and numeric. B cMD Number £ cmp Validity Medium
DQ-3 Valid trading record counterparty CMD IDs should be of length 8 and numeric. £ cmp Validity Medium
Counterparty Risk Rating should always 3 ’ - 3
DQ-4 Counterparty Risk Rating should always be populated B country of Risk = IDQ Completeness Medium
be populated
DQ-4 DQ-4 CMD IDs should be of length 8 and have only numbers. £ cmp Validity Medium
SIC Code changes must be updated before month end - S
bDaio Updated before month end § & DARWIN Timeliness Low
stress testing
DQRULE-11 DQRULE-11 This is DQ Rule number 11 B AssetClass £ DARWIN Consistency High
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Support extended for creating Widgets

New Widget X

Select the source for the widget and visualization

Widget Source @® saved Search O Text
L}
Visualize As”* p- — v E
Source” ProcessincludeChildren ™
Visualize By * Result v
Focus” Data Quality X —
———————————
Title” ProcessincludeChildren ‘
Description * Include children ' Result
BB Green(12)
18 B8 Red (3)
B8 Amber (2)

B Undefined (1)

Data Quality
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Axon EDC Integration
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Onboarding when duplicate Systems are linked to two
Dataset with same name

*In7.2.1, System ID has been added as an optional field in Data Set bulk upload

— System ID can now be used for lookup and resolving the respective unique associated System

— Onboarding / Data Set creation is now successful in duplicate System scenarios

A | B | ¢ | p | E | f »&&& | H | 1 | 3 | x | L | M | N | o | P | a | rR | s | T*

| Parent !
stem System Parent User User Govern
Definiti Axon hort Short Lifecycl Axon Glossar Glossar Glossar User First Last User ance Segme
. |Ref. Name on Usage Viewing Type SystemID Name Name e Status yRef. yName yName Email Name Name LanID Role nt
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Axon Data Governance /7.2.2 — Highlights at a glance

Engaging

 Unison filtering improvements
« Dynamic date filter
» Filtering on Last Loging
» Map enhancements
» Show Legend on Maps
« System interface details in
System map
» Bulk Upload improvements

© Informatica. Proprietary and Confidential.

Integrated

« Axon - EDC Integration
» Additional resources — MDM
« Extended Support - Tableau
« DQ Automation support
* ADLS Gen2, Parquet file on S3
 Notification enhancements
« Additional Email notifications
« Admin config for default freq

Qutcomes

Object Delete improvements
SSO Support for Quick Look
Change Request APIs

Multi select custom field type
Shared search/Dashboard
ownership transfer

(‘ Informatica



Unison date filter
enhancements

» Ability to create search using Dynamic Date Created Date

* Filter Date fields on a particular date range Add new fiter
or for past number of days

Do not include Children

Last Login

Add new filter

t Operations

48 © Informatica. Proprietary and Confidential.

All selected (4)

Last 10 Days

O Last ld

3 selected

Select options




Map enhancements

- Legend on Maps to define the different lineage represented in Maps

- System Interface information in Maps

MAPS
Map type: Layout: Overlay: Filters:
System Lineage v~ Left-To-Right v Oy >~ None v B~

i

DARWIN
L MQ Series Interface
Ad Hoc syncﬁronisation of f )é -
cogdes FXM
Ad Hoc synchronisa tion of
olie MQ Serie$ Interface
8- ° B=-
MRDS CMD
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All selected (10) v

NEXUS

Local DWH

= @ Q clolRA @ =#||E
ﬁ Show or Hide Interface ’ -

- Interface Lineage

.- e Outbound Interface Lineage

Inbound Interface Lineage

Attribute Lineage

SAP - HR

CRR
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Bulk Upload Improvements

» Two new Bulk Upload capabilities introduced
— System x Onboarding Rule

* Only one rule can be associated with a system

» Uses Rule Name to identify the Rule

 If a System x Onboarding Rule association already exists, new Rule will replace the existing one
— Data Quality x Stakeholder/Role
« Allows for Stakeholder to be Uploaded for both Standard and Local DQ Rule
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Notification Improvements

« Two new email notifications added

Email notification when the user is Tagged in a
CR discussion

Stakeholder notification when the DQ score for a
Data Quality rule goes down

Green -> Amber
Green -> Red
Amber -> Red

51 © Informatica. Proprietary and Confidential.

My Axon Actions

Hi Sreenivas R, You have been mentioned in the workflow discussion for a change
request. Review the following details.

Workflow Discussions

Mentioned by: John Admin
Change Request: config_dnr View Comments

Timestamp: 05-Oct-2021 01:41:02

Comment

Sreenivas R : Please review the changes

Hi Vaman Pai,

Low Data Quality Results

After running the data quality rules, the result for the LDQ_Vaman3 rule has changed from

Green to Red .

Informatica




Simplified Object Deletion

- Improves deletion capability to allow for Hierarchy deletions such as Glossary,
System, Policy

* Removes the need to deleting stakeholders, parent child relationship as pre-requisite
to delete the object

- Warning messages are displayed when there is dependency

* In order to delete an object with warning messages, user needs to click Yes,
continue hyperlink in the confirmation message

* For Glossary, Alias removal is no longer required
- System to be deleted can have Dataset and DQ Rule associated

- Dataset deletion allows if it has Attributes associated
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Multi-Select Custom Fields

* New Custom Field type added to allow for Multi Select
* Like Dropdown, user can select from the dropdown but can select more than one item

- Search/Filter works similar to single select dropdown

Edit Custom Field x
Display Name * Area of Interest
(J Mandator Y
Description | Enter a description for the field * -
ption | Enter a description for the fie! G|OSS¢’:ll'y Name Legal Entity X f
P
Finance
AYpes Multiple Selection Dropdown - _
OPTIONAL FIELDS .
Values * Finance = Marketing
Marketing
Support Support
RnD = Usage
Consulting Z
RnD
Default Value
Consulting
Placeholder Text Enter instruction for the field

Area of Interest Support x | Consulting x S
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SSO Support for QuicklLook

* Users can use the SSO capability for
Quick look application

* Need to provide the refresh token
available from Axon Ul

- Seamless navigation from Axon Quick
look to Axon Ul with SSO

© Informatica. Proprietary and Confidential.

(* Informatica Axon Quick Look Settings X

Hotkeys Preferences Server

Protocol: (®) HTTP (O HTTPS

Host: ‘ Axon_Host_Name

Port: 9999 =
Log in with: RefreshToken = |~
Refresh Token: ’ 0000000000000 0000000000

@Get Refresh Token

Test

Cancel

(‘ Informatica



Change Request API's

 Supports Create, Retrieve, Start, Update and Cancel Change Requests
* Retrieve APl works for both auto and manual created Change requests in Axon

 Others work only for manual created Change request

Operation [API-URL T ethod

Create http(s)://<Axon_host>:<port>/change-request/api/v1 POST
Retrieve  http(s)://<Axon_host>:<port>/change-request/api/v1/{change_request_id} GET
Start http(s)://<Axon_host>:<port>/change-request/api/v1/start POST
Update http(s)://<Axon_host>:<port>/change-request/api/v1 PUT

Complete http(s)://<Axon_host>:<port>/change-request/api/v1/{change_request_id}/complete PUT
Cancel http(s)://<Axon_host>:<port>/change-request/api/v1/{change_request_id}/cancel PUT

change request id: Enter the ID of the change request that you want to cancel.
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Transfer Ownership of Shared Searches and
Dashboards

» SuperAdmin can transfer the ownership
of Dashboard and Shared searches from
one Axon user to another

Previous Owner User Inactive From Dashboard Name Description Sharing

* Transfer of ownership is possible only if
the owner is Inactiveuser e e

» Does not permit transfer of ownership
between two active users
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Axon Data Governance /.2.3 — Highlights at a glance

Engaging Integrated Outcomes

» Axon — EDC Integration Changes for

* Quick look browser plugin

, _ « Additional resources — Azure Process/Project/Policy
> DI i 1 G e el e o ey Synapse, Azure Blob Storage, relationship to Dataset / Attribute
206 WliEIT ) 85 Daligke Google Cloud Storage and SAP « Dashboard interaction
> Cnse Elite] DR IuRET S/4 Hana 2020 improvements for user actions
shlielieerieis *  Onboarding of Synonyms - Object pages enhancements
* Ablllty to filter based on current « Support for additional fields of . Hierarchy sortedin
USEr . SAP HANA . Alphabetical order by Default
» Filter Glossary using Format « AXON-DQ Integration . History tab sorted in
ot * Support for Amazon Redshift descending order of date by
and Partitioned Parquet file in Default
Amazon S3 .

Accessibility compliance (WCAG
2.0) standards
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Quick Look browser plugin
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Quick Look browser plugin LD

Welcome to [ Apvestinet | Q |@

*  Browser extension to search for objects in Axon Axon Quick Look © rovoerciin
o b

- Configurable Facet views and order based on | o ivesiman ncome

Use this quick search utility for The return received by insurers

. . . .

I n d IVI d u a I Sett I n S ' discovery. Just type in anything you from their investment portfolios
want on the top input start searching including interest, dividends and
go to Axon directly for more function realized capital gains on stocks. It

doesn't include the value of any

Navigate to Objects page from search results B . e

Net Investment In... GLOS-29.

Supports Hotkeys to initiate the plugin

income earned during the year less
investment expenses and

Authentication is based on browser session

Supports SSO, LDAP and Native users login e

Users can download from Axon Help Center or o z

Organization IT can push for user's browser e
Supports Chrome and Microsoft Edge browsers e

https://docs.informatica.com/data-quality-and-governance/axon-data-governance/7-2-3/quick-look-browser-extension-user-

quide/preface.html .
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https://docs.informatica.com/data-quality-and-governance/axon-data-governance/7-2-3/quick-look-browser-extension-user-guide/preface.html

Data Marketplace collection
view and filtering for Dataset




Data Marketplace collection view for Dataset in Unison

* Data Collections associated with Dataset is displayed in Unison

- Users can navigate to Data Marketplace from the Collections displayed

Al 80
Informatica Data Governance ¥ Search Maps My Items v Create v Q i} A John Admin v (7]

FIND v Q Enter the search text §$ Data Sets v Y Filter Q Search v

< DATASETS ATTRIBUTES & SYSTEM GLOSSARY DATA QUALITY PEOPLE POLICY PROCESS
XZ oz 62 0f 588 —_— 1101127 = 3201594 @ 120f 280 15 of 543 g 50f106 210137 +
BB List A% Dashboard M Bulk Delete *{ Bulk Update @ Bulk Publish @ BulkMigratev £+
Ref. S Name o Definition o Lifecycle Data Collections System Short Name
3 £ FXTrade Description of core data elements on the FXM trading record. Confirmed FX Trade é FXM
Confirmed ISO Country List
4 £ S0 Country List IS0 country list as sourced from ISO with some modifications. Confirmed 1SO Country List £ CcMD %
Country Risk Reportin
n § Country Risk Reporting Aggregation of credit risk exposures at the country level. Confirmed Country Risk Reporting = MAGELLAN i H
A C Category : Market Data Country Risk Repor&ng
152 & Customer Data Record In this EUC we maintain customer data for reporting purposes Confirmed Customer Data Record , +1 é AVX
= i 1 d, +
163 € Collateral Record desc Draft Collateral Record , +1 = PDSYS Conf"med CU STOH er Data ReCOI d : ]
174 £ MCD Data MCD Data Draft MCD Data, +1 §3 MCD Monitoring Dialogs
176 $ Party Data Data related to any counterparty actively trading with the bank. Draft Party Data é CcoB
177 & Customer Data Record Core customer data as it is stored in the salesforce application Draft Customer Data Record §3 Salesforce CRM
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Data Marketplace collection view for Dataset

- Data Collections information is displayed in summary tab of the objects

Informatica Data Governance ¥ Search My Iltems v Create v

<> 152: Customer Data Record

=== pata Setin AVX

SUMMARY ATTRIBUTES RELATIONSHIPS STAKEHOLDERS ENTERPRISE CATALOG VALUES DATA QUALITY IMPACT HISTORY CHANGE

DEFINITION

In this EUC we maintain customer data for reporting purposes

Ref.: 152

System Short Name: £ AVX

Glossary Name: M Party Data (oanerora]

Data Collections @: & Customer Datapygecord In this EUC we maintain customer data

for reporting purposes

> DOCUMENTS 0 RECORD
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Data Marketplace collection view and filtering for

Dataset

 Users can filter Datasets which are Published to Data Marketplace.

Informatica

FIND v

DATA SETS

<
= 1130r112

PEOPLE
543 of 543

EH List

Data Governance ¥ Search

Q Enter the search text....

@ ATTRIBUTES
588 of 588

ROLE

\!J 1151 of 1151

/% Dashboard

Ref. S Name

My Items v Create v

Data Set in Data Marketplace
POL

106

Add new filter

Definition

=

3 S
4 =

Legal Entity Record

Trading Counterparty

FX Trade

ISO Country List

© Informatica. Proprietary and Confidential.

& Data Sets v

Select options

[] published

D Unpublished

Y Filter

el

& ’ 4

h QUALITY
280

Ik Publish

Data Collections

Q Search

John Admin v

My searches v

' Bulk Migrate v

o

System Short b

The Legal Entity Record construct captures the key attributes that describe cus... [

Show More ]

The trading counterparty captures all required details to identify the client, ...
More]

Description of core data elements on the FXM trading record.

I1SO country list as sourced from ISO with some modifications.

Confirmed

[ Show :
Confirmed

Confirmed

Confirmed

FX Trade

ISO Country List

‘ Informatica

CMD

FXM

FXM
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Unison and Dashboard
enhancements
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Ability to filter based on Current user

« Current logged in user will be a variable to filter searches based on user logged into Axon.

 All facets will have “Created By" filter and option to select the current logged in user can be
used to Save searches

65
Informatica Data Governance ¥ My Items v Create v Q = J 3 John Admin v (2]

FIND v Q Enter the search text.... M| Glossary v Y Filter Q Search My searches v

SYSTEM Name, Alias Names = R
126 of 126

ROLE

<> DATASETS % ATTRIBUTES
= \!J 1146 0f 1146

<= 111of111 588 of 588

Created By Search and add people

BB List /% Dashboard Bulk Update £ o 2V

Add new filter

> Name < Type Definition Lifecycle
Me (current user) “
EJ Party Data |W Parties are entities that have a econo 2B T E IR i Er—— P — - At
l the co... [Show More] ohn Admin (admin@informatica.com)
Mason Johnson (mason johnson@diaku.com)
— Party Classifications of all sorts. Good classifications are exhaustive sets
> EJ Party Classifications | ENTITY S ) Approved
of.. [Show More] John Campbell john_.campbell@diaku.com)
> Ej Party Type Classification of the type of party. Johnny Palmer (johnny palmer@diaku.com) Approved
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Ability to filter based on Current user

« People facet will have additional filter to choose the Current logged in user to search based on
Stakeholders

« Helps to share searches and Dashboards which displays results for current logged in user.

All 65
Informatica Data Governance ¥ Search Maps My Items v Create v Q =} a John Admin v [ 2]

FIND -~ Q Enter the search text.... 2 People ~ Y Filter Q Search My searches v

<> DATASETS ATTRIBUTES . SYSTEM 3 selected ~ % ~
" 111o0f111 588 of 588 -

User ~ Search and add people v
BB List A% Dashboard Ml Bulk Update o I
Add new filter ~ Q John
First Name < Last Name < Email
Me (current user)
2 John 2 Admin admin@informatica.com Head of Client Operati Z .
John Admin (admin@informatica.com)
2 Martin 2 Hirst ip1 @diaku.com Mason Johnson (mason johnson@diaku.com)
2 Jean 2 Dubois ip2@diaku.com John Campbell (john.campbell@diaku.com)
8 Ken 8 Stool ip3@diaku.com Johnny Palmer (johnny palmer@diaku.com)

© Informatica. Proprietary and Confidential. ( Informatica



Changes for Process / Policy / Project
relationship to Dataset / Attribute




Removed requirement to establish relationship

- Mandatory requirement to have relationship between Process / Policy / Project to System
and Glossary of Dataset / Attribute has been removed

*  Process / Policy / Project can be linked to Dataset / Attribute directly

 Existing relationship between Process / Policy / Project with Glossary / System is retained
during upgrade.

- }\ [ ' J\

Process / W Dataset / } Process / W Dataset / }

»
>

Policy / ProjectJ Attribute

[
»

Policy / Projectj Attribute

f Glossary [ Glossary

.
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Unison search displays directly and indirectly connected
objects

Searching with a Process / Policy / Project in Unison display both directly and indirectly
connected objects in Glossary, System, Dataset and Attributes and vice versa

Example : Searching for a Process lists all Datasets which are linked directly and indirectly

though Glossary, System and Attribute
PROCESS -> DATASET
PROCESS -> SYSTEM -> DATASET
PROCESS -> GLOSSARY -> DATASET
PROCESS -> GLOSSARY -> ATTRIBUTE -> DATASET
PROCESS -> ATTRIBUTE -> DATASET

Searching for a Dataset in Unison will list all the Process which are linked directly and indirectly
DATASET -> PROCESS

DATASET -> ATTRIBUTE -> PROCESS

DATASET -> GLOSSARY -> PROCESS

DATASET -> GLOSSARY -> ATTRIBUTE -> PROCESS

DATASET -> SYSTEM -> PROCESS
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Dashboard interaction
enhancements for user
actions
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Dashboard interaction enhancements

« Change requests filtered and displayed in users My Account page based on the timeline
selection in Dashboard widget

Informatica Data Governance ¥ Search Maps My Items v Create v 1 John Admin v (]
A Home 8H My Dashboard x
Saved Searches v Roles Not Accepted | 54 out of 191 v Change Requests v
Recent Most Viewed Contributing Raised by Me
Name Description “
‘ M Process (32)
ProcessincludeChildren Include children M Glossary (12)
54 B system (3)
Project (2) B Less than 7 days (1)
B8 Committee (2) ] 3 B 71030days (0)
I Others (3) I8 More than 30 days (12)
CONTRIBUTING @ShowAll e Complete  §§v
Ref Title Description Type Status
63 B Update Legal Entity for updating legal entity Request For Change Running

1 record

N
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Dashboard interaction enhancements

- Navigating to appropriate facet Responsibilities tab under My Account page from Dashboard
for Roles Not Accepted widget

74
Informatica Data Governance ¥ Search Maps My Items v Create v ‘ John Admin v 0
A Home EQ My Dashboard x
Saved Searches v Roles Not Accepted | 54 out of 191 v Change Requests v

Recent Most Viewed -
Informatica Data Governance v Search Maps My Items v Create v a John Admin v o
Name Description
John Admin .
B Process (32) People BRI
ProcessincludeChildren Include children B Glossary (12)
54 | | B system (3)
I PijEC( ( 2 ) ABOUT ME RESPONSIBILITIES @ ACTIVITY STREAM CHANGE REQUEST ASSIGNED SEGMENTS ASSIGNED ROLES

@ BB committee (2)
B Others (3) Al @& ata @) system @) System Interface (@) clossary @) Data Quality (@ :ocess (4] Project (€ policy (@ Capabily @) Committee ()
»

B PROCESS o
Role Role Type Name Type Role Accepted Role Accepted On Segment
v No v
= B

Process Owner Ownership Role @ IFRS 9 Impairment Calculation Process No Enterprise
Process SME Knowledge Role @ Set up for trading in Swaps Systems Process No Enterprise
Process Owner Ownership Role @ Convert Lead to Opportunity Process No Enterprise
Process Steward StewardShip Role @ Convert Lead to Opportunity Process No Enterprise
Process Owner Ownership Role ® EU Gaming PIl Data Retention Process Process No Enterprise
Process Owner Ownership Role ® Gather relevant data Process No Enterprise
Process Owner Ownership Role @ Is the PlI corporate or customer related? Process No Enterprise
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Security, Accessibility and
PAM updates
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Accessibility

- As part of Accessibility (WCAG 2.0) Compliance standards, addressed most of the
Critical and High issues around following components:
» Tabs
* Navbar
* Dropdown Menu
» Dropdowns
« Autocomplete (Quick Search)

« Will continue to address accessibility issues across the application for WCAG 2.0
compliance in Axon 7.3

Security Updates

* The Log4j RCE Zero Day vulnerability is addressed in the following ways:
— Axon 7.2.3 adopts Log4j version 2.17.1 for the Axon Agent. It was released on January 15, 2022.

— Axon 7.2.3.1 includes an update of Elasticsearch that uses Log4j version 2.17.1. It was released on February 28,
2022.
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PAM Updates
| mon721 | Axon722 | Awon723

OS Support RHEL v8.4 Cent 0S 8.4 RHEL v8.5
Cent0S7.8&8.3 OEL 8.x Cent 0S 8.5
SUSE 15 (SP1&SP2) SUSE 15 (SP3)
DQ/EDC/DPM 10.5.0.1 10.5.1 10.5.1.1
EDC Resources AWS Glue Informatica MDM Azure Synapse
Power BI Azure Blob Storage
Google Cloud Storage
SAP S/4 HANA 2020
Additional EDC Fields Tableau resource - SAP HANA -> Calculated Attribute and

Calculated Measure
- Synonyms for Relational DB Sources

Source for DQ - ADLS Gen2 (delimited files) - Amazon Redshift
Automation - Amazon S3 Parquet - Partitioned Parquet files in Amazon S3
Active Directory Added support for Microsoft Active

Directory 2019
Kubernetes Supported via Utility Support added for external Postgre SQL DB
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Hardware Specification

Low Production
Specification

CPU Cores 8 cores 16 cores 24 cores
Contact Support
RAM 24 GB 40 GB 48 GB for
. recommendation
Disk Space 100GB 200 GB 300 GB

CPU Clock speed of 2.8 — 3.2 GHz and Disk Transfer Speed of 1.8 GB/sec or higher
is recommended for Optimal Performance and low latencies
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Axon Data Marketplace
Update for vi/.2.X
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3 Home Search

Data Marketplace

Welcome to the Axon Data Mark
published data collections on a

Asset Management

Human Resoures

& Customer360i Enriche...

place! Publish data collections that other teams in your organization can use. Similarly, find and request access to

& Warranty Master Data ...

5 consumers 97%

Finance

D
financ

1s

in

al performance, ance syst
i for the domain o

Products

domain is an operational
e definition of products. Its

ollection of prod

ization is the

ategory

& Patient Encounter Data

4 consumers 03
88 Tiles B st

Healthcare

Healthcar

Risk & Compliance

Data assets that report on outcomes for the organization's
and compliance practi

cases, involving

jovernance, risk
across division:
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Axon Data Marketplace

A storefront, with order management, and governed provisioning capabilities

namh- @

Informatica
A



Leverage integration and metadata-driven intelligence and automation
to open up availability of curated and governed data to data consumers




Enable data consumers to easily find,
understand and access data they need




Deliver the data when needed and keep track of
who is using what data for what purposes




Governed Data Democratization with a Data Marketplace

(% &

Find Relevant Greater Trust  Broader & More Reduce Cost
Data Assets & Compliance  Consistent Use of Operations

I;;r' Companies that empower employees to consistently use data as a basis
for their decision making, are nearly twice as likely as others to report

Informatica
A



Axon Data Marketplace 7.2.x Priorities

- Expanded APIs for Marketplace
- Data Collection Management
* Order Processing /L <>
* Delivery Target Management
« Consumer Access Management

- Order Context, attachments

 Operationalize Marketplace Management C

- Marketplace Merchandising ﬂ
- Search Enhancements U
- Attribute level search for Data Collections

- Data Collection Enhancements
* Glossary description tooltips

85 © Informatica. Proprietary and Confidential. G |nf0rmatlca



Order Context - Attachments

Al 086 -
Informatica Data Marketplace ¥ Explore My ltems v Create v b ‘. John Admin v (2]

3 Home Search Data | Own Tasks @D History £ Settings L4 C O n S u m e rS Ca n p rOV| d e

Tasks » Fulfilment Requests > @ Ord000260 B rutsuuvewr stace documentation to su pport
their business justification to

Timeiine Order Summary request data on Marketplace

REF. NSE--1

e # NSE Customer Dats » Data Owners or Technical

Thanks, John, let me know when the access point is available so | can query from my analytics working environment. PURPOSE NSE Customer Data - Combines customer

dimension data into a business view. Contains OW n e rS Ca n p rOVi d e g U i d i n g
Pll and highly sensitive data. .
. documentation to support
& You commented on 15 Apr 2022 at 10:26 am .

Hi Hans. Please refer to the data enrichment dictionary documentation below for guidance on how to incorporate this customer :gzz:sﬁjelrgoe[rr::g?al:)hics a C C e S S O r d e S | re d U S e Of -t h e

profile data into your analytics. Thanks. #Customer Outreach d _ta S e C i fi C _tO _t h e O rd er

DATA OWNERS & Donna Heimbaugh, & Tom Simms, a ) p
& Steve Hill, & John Admin, & Zedi Qureshi

SeIviceNow cket = crearnd TECHNICALOWNERS & Donna Heimbaugh, & Valentine Moore ¢ S u p p | e m e n t S atta C h e d
3 PENDING APPROVAL dOCU mentatlon |n the Data
& Hans Stahl placed the order on 16 Jul 2021 at 09:42 am AttaChmentS Edit COl |eCtlon, |f req U | red

Can | get this customer match reference file for my territory analytics project?

M Data_Enrichment_Dictionary.pdf 15 Apr 2022 ° |nC|Uded as part Of the Order
Data_Enrichment_Dictionary - CORE pdf 15 Apr 2022 record, aUdltab|e Over t'me

B FULFILLMENT STAGE

& Hans Stahl
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API sup

Axon Data
Marketplace
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Informatica Simplifies Data Democratization with New Al-Powered
Solution for AWS Lake Formation

Company deepens relationship by joining AWS ISV Workload Migration and AWS
Data-Led Migration programs

REDWOOD CITY, Calif., Dec. 1, 2021 — Informatica® (NYSE: INFA), an enterprise cloud data management leader, announced today at

AWS re:lnvent a new solution to democratize access to cloud data lakes on Amazon Web Services (AWS), using AWS Lake Formation.

Informatica’s Axon Data Marketplace can now empower business users across any level within an organization with access to AWS

Lake Formation data with the trust and security needed to make informed business decisions.

Informatica Axon Data Governance uses Al and machine learning to automate the tasks of finding data, measuring its quality, and
locating the right people to help govern it. Leveraging Al-powered automation through Informatica’s Intelligent Data Management

Cloud™ (IDMC), organizations can cost-effectively scale and democratize data, delivering business insights and value.

“Data is critical to our business success,” said Aravind Jagannathan, Chief Data Officer at Freddie Mac. "With Informatica and AWS,
we are on a data and cloud modernization journey where a secure, efficient and trusted data platform built with Informatica’s

innovations on AWS helps us to transform the vast amount of data into actionable insights”

Informatica Offers Self-Service Data Access for AWS Lake Formation

Joint Informatica-AWS customers can now empower business users with access to AWS Lake Formation governed data via
Informatica’s business-user friendly, data policy-enforcing Axon Data Marketplace. This solution provides customers with the ability

to:

s Provide business users with self-service, high-quality data assets while ensuring compliance with all data management policies
from access controls to complex policy enforcement for CCPA, for example.

s Automate and accelerate data access request submissions and approvals, connecting data owners directly with business
users, removing dependence on IT, and technical resources to provision data for analytics.

e Empower business users to quickly access trusted data assets without having to consult data owners and IT based on critical

data context including data quality assessments, data set certification, and business glossary associations

livery

ables desired asset to
Data Marketplace
ed may already be in
is needed or, if not in
ay be needed.

ccesses the Marketplace and
an order for an existing data set

lows through marketplace
al process

provisioning triggers a CAl
s to begin the required
oning

rieves additional metadata from
required (e.g. physical location of
and composes request

Is client endpoint for a custom
on/authorization framework.

liates a CDI mapping task

pvisions data to the data lake
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